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Introduction

The numerical treatment of thin structures with a membrane theory is much simpler than 
with a shell theory due to the assumption of zero bending stiffness. However, for some 
load cases, this assumption is disadvantageous. For instance, when a membrane is 
subjected to compressive stresses, it may trigger wrinkling which is an equilibrium 
instability. This undesirable limitation can be overcome with the incorporation of a 
numerical wrinkling model that removes such instabilities.

In this example, a torque is applied to the inner edge of a circular annulus-shaped 
membrane while the outer edge is fixed. This causes wrinkling due to torsion. The example 
has been studied by different researchers (see Ref. 1, Ref. 2, Ref. 3, and Ref. 4). The 
results are similar albeit with some differences. The mesh pattern and discretization used 
in these research papers are different even though the same geometry, material, and 
boundary conditions are used. In this example, the model is set up in four different ways 
with respect to mesh pattern and discretization order, corresponding to each of the 
research papers.

Model Definition

The geometry consists of a thin circular membrane with an outer radius of 12.5 m and an 
inner radius of 5 m. it is fixed on the outer edge. A prescribed rotation of 10 degrees is 
applied on the inner edge.

The linear elastic material is modeled using both isotropic and orthotropic properties. The 
linear stress-strain relationship defined in Ref. 1 on compliance form reads

 (1)

For the isotropic case, Young’s modulus is E = 100 kPa and Poisson’s ratio is ν = 0.3. Note 
that in Ref. 4, Poisson’s ratio is reported as ν = 0.45. This is assumed to be a typing 
mistake, since they refer to Ref. 1 for material properties.
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In the orthotropic case, the Young’s moduli are E11 = 100 kPa and E22=1000 kPa, 
Poisson’s ratio is ν12 = 0.3, and the shear modulus is G12 = 38.5 kPa. The elements of the 
elasticity matrix in the linear stress strain relationship σ = C ε are given in Table 1.

M A T E R I A L  P R O P E R T I E S

The constitutive relation for a linear elastic material used in COMSOL Multiphysics is

where the elements of D are related to the elements in C as

It is assumed that the stiffness in the third direction is the same as in the second direction, 
since the out-of-plane data is not available in Ref. 1. The elements D33, D55, and D66, 
cannot be equal to zero because the Membrane interface includes degrees of freedom for 
the out-of-plane strains. However, the choice of out-of-plane data has no effect on the 
results.

Although the material data in principle can be entered using the Isotropic or Orthotropic 
options in the Linear Elastic Material subnode, the elasticity matrix computed in COMSOL 
Multiphysics does not match the values given in Ref. 1 even for identical Young’s modulus, 
Poisson’s ratio, and shear modulus. The reason for the discrepancy is the difference 
between three-dimensional and two-dimensional membrane theory. The authors in Ref. 1 
used two-dimensional membrane theory where the thickness direction is not part of the 
constitutive model, while COMSOL Multiphysics employs a full three-dimensional 
representation where the membrane thickness enters explicitly. This gives a different 
elasticity matrix for the same material data. In order to match the values in Ref. 1, the 
elasticity matrix is first computed, and then these values are entered under the Anisotropic 
option in the Linear Elastic Material node.

TABLE 1:  MATERIAL PROPERTIES.

Property Variable Isotropic Model Orthotropic Model

Elasticity matrix, 11 element C11 109.89 kPa 100.91 kPa

Elasticity matrix, 12 element C12 32.967 kPa 30.272 kPa

Elasticity matrix, 22 element C22 109.89 kPa 1000.91 kPa

Elasticity matrix, 33 element C33 76.923 kPa 77 kPa

σ[ ]3 3× D[ ]6 6×  : ε[ ]3 3×=

D11 C11 D12 C12 D22 C22 D33 C22 D44
C33
2
--------- D55

C33
2
--------- D66

C33
2
---------=,=,=,=,=,=,=
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F I N I T E  E L E M E N T  M E S H

In Ref. 1 and Ref. 4, three-noded triangular mesh elements are used, but the mesh 
patterns differs. In Ref. 3, four-noded quadrilateral elements are used with 120 mesh 
elements, while Ref. 2 uses nine-noded quadrilateral elements with 180 mesh elements. 
This gives four different mesh pattern to investigate, as shown in Figure 1, Figure 2, 
Figure 3, and Figure 4.

Figure 1: The triangular mesh with 240 mesh elements from Ref. 1.
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Figure 2: The triangular mesh with 240 elements from Ref. 4.

Figure 3: The quadrilateral mesh with 120 elements from Ref. 3.
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Figure 4: The quadrilateral mesh with 180 elements from Ref. 2.

Results and Discussions

In all the following figures, four plots corresponding to four combinations of mesh pattern 
and discretization are presented. The order of the plots is the following and matches the 
legends position when multiple legends are used:

• Upper left — Three-noded triangular elements as shown in Figure 1

• Lower left — Three-noded triangular elements as shown in Figure 2

• Upper right — Four-noded quadrilateral elements as shown in Figure 3

• Lower right — Nine-noded quadrilateral elements as shown in Figure 4

Another point to note is that in all the following figures, Resolution and Smoothing in the 
plot quality section are set to No Refinement and None respectively, in order to represent 
the computed values as close as possible. Using smoothing would give significantly better 
plots, but it would hide some interesting features in some of the solutions.

Figure 5 and Figure 6 show the wrinkled regions for isotropic and orthotropic materials, 
respectively. For the isotropic case, the wrinkled region is symmetric and spreads in almost 
all elements except the outermost ones, close to the fixed outer boundary. For the 
orthotropic case, the wrinkled region is not symmetric, and it is localized near the inner 
6 |  T O R S I O N  O F  A  C I R C U L A R  M E M B R A N E



edge. Depending on the selected mesh pattern and discretization, the wrinkling region 
varies significantly.

The first principal stress and the tensile direction for the isotropic and orthotropic cases 
are shown in Figure 7 and Figure 8, respectively. Figure 9 and Figure 10 show the second 
principal stress along the wrinkling direction. The lowest value of the second principal 
stress is almost zero, as is expected since the membrane cannot sustain compressive 
stresses. The principal stress pattern and directions match those presented in Ref. 1. 

The maximum values of the first principal stress obtained with COMSOL Multiphysics for 
the different cases are given in Table 2 and Table 3. Some papers did not provide the 
values of maximum first principal stress explicitly. These are marked as Not Available (NA). 
When only the maximum value of the first principal stress is concerned, the worst match 
between reference values and COMSOL values is found for the three-noded triangular 
elements presented in Ref. 4, while a good match is found for three-noded triangular 
elements presented in Ref. 1. The COMSOL values for the mesh pattern and 
discretizations presented in Ref. 2 and Ref. 3 are in line with target values.

It is clear that the results are highly mesh and discretization dependent. In particular, the 
linear elements are performing badly in this example. The four-noded quadrilateral 
elements show a triangular stress pattern similar to the three-noded triangular elements, 
see Figure 7 and Figure 8. It is clear that the nine-noded quadrilateral elements are 
performing better considering the obtained maximum values as well as the stress and 
wrinkling pattern.

TABLE 2:  MAXIMUM PRINCIPAL STRESS FOR ISOTROPIC MATERIAL.

From σp1 from 
Ref. 1

σp1 from 
Ref. 2

σp1 from 
Ref. 3

σp1 from 
Ref. 4

Reference 26.9E3  26E3 NA 25.9E3

COMSOL 25.90E3 22.88E3 26.9E3 17.48E3

TABLE 3:  MAXIMUM PRINCIPAL STRESS FOR ORTHOTROPIC MATERIAL.

From σp1 from 
Ref. 1

σp1 from 
Ref. 2

σp1 from 
Ref. 3

σp1 from 
Ref. 4

Reference 270.5E3 NA NA 230E3

COMSOL 235.7E3 247E3 296.5E3 163.4E3
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The maximum values of wrinkling measure obtained with COMSOL Multiphysics are 
compared to the reference values in Table 4. The agreement between reference values and 
computed value are good. 

The choice of mesh pattern shown in Figure 2 seems not desirable for this example. The 
physics is symmetric while the mesh is antisymmetric. If the counterclockwise torque 
(same as all references) is replaced by a clockwise torque, then the results are the same for 
all mesh and discretization patterns except the one used in Ref. 4. With clockwise torque 
the maximum first principal stress for isotropic and orthotropic material reached 
26.03 kPa and 270.23 kPa, respectively. This can be compared with 17.48 kPa and 
163.4 kPa obtained with counterclockwise torque. It can be noted that these values match 
what is reported in Ref. 4 much better.

Figure 5: Wrinkled region with isotropic material for different mesh types.

TABLE 4:  MAXIMUM VALUES OF WRINKLING MEASURE FOR ISOTROPIC MATERIAL.

From β in material frame from 
Ref. 3

Reference 0,19118

COMSOL 0.20824
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Figure 6: Wrinkled region with orthotropic material for different mesh types.

Figure 7: First principal stress with isotropic material for different mesh types.
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Figure 8: First principal stress with orthotropic material for different mesh types.

Figure 9: Second principal stress with isotropic material for different mesh types.
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Figure 10: Second principal stress with orthotropic material for different mesh types.

Notes About the COMSOL Implementation

A wrinkling model based on the modified deformation gradient is incorporated within the 
membrane theory using the Wrinkling feature, which solves a set of nonlinear equations 
using the Newton–Raphson method.

Since the unstressed membrane does not have stiffness in the normal direction, the 
Stabilization feature is added in order to stabilize the model.
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Buckling_and_Wrinkling/membrane_torsion

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics > Membrane (mbrn).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select General Studies > Stationary.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Model Parameters
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Model Parameters in the Label text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
membrane_torsion_parameters.txt.

Isotropic Material Properties
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Isotropic Material Properties in the 
Label text field.
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3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
membrane_torsion_isotropic_properties.txt.

Orthotropic Material Properties
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Orthotropic Material Properties in 
the Label text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
membrane_torsion_orthotropic_properties.txt.

For this model four different mesh patterns are used. Import the meshed geometries to 
save modeling time.

T R I A N G U L A R  M E S H ,  P A T T E R N  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, type Triangular Mesh, Pattern 1 in the Label text 
field.

Import 1
1 In the Mesh toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
membrane_torsion_tria_mesh1.mphbin.

5 Click Import.

T R I A N G U L A R  M E S H ,  P A T T E R N  2

1 In the Mesh toolbar, click Add Mesh and choose Add Mesh.

2 In the Settings window for Mesh, type Triangular Mesh, Pattern 2 in the Label text 
field.

3 In the Mesh toolbar, click Import.

1 In the Settings window for Import, locate the Import section.

2 Click Browse.

3 Browse to the model’s Application Libraries folder and double-click the file 
membrane_torsion_tria_mesh2.mphbin.
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4 Click Import.

Finalize
In the Model Builder window, right-click Finalize and choose Build All.

Q U A D R I L A T E R A L  M E S H ,  P A T T E R N  1

1 In the Mesh toolbar, click Add Mesh and choose Add Mesh.

2 In the Settings window for Mesh, type Quadrilateral Mesh, Pattern 1 in the Label 
text field.

Import 1
1 In the Mesh toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
membrane_torsion_quad_mesh1.mphbin.

5 Click Import.

Finalize
In the Model Builder window, right-click Finalize and choose Build All.

Q U A D R I L A T E R A L  M E S H ,  P A T T E R N  2

1 In the Mesh toolbar, click Add Mesh and choose Add Mesh.

2 In the Settings window for Mesh, type Quadrilateral Mesh, Pattern 2 in the Label 
text field.

Import 1
1 In the Mesh toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
membrane_torsion_quad_mesh2.mphbin.

5 Click Import.

Finalize
In the Model Builder window, right-click Finalize and choose Build All.

The first study runs with linear shape order of the elements. Change the default Quadratic 
discretization to Linear.
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M E M B R A N E  ( M B R N )

1 In the Model Builder window, under Component 1 (comp1) click Membrane (mbrn).

2 In the Settings window for Membrane, click to expand the Discretization section.

3 From the Displacement field list, choose Linear.

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1) > Membrane (mbrn) click 

Linear Elastic Material 1.

2 In the Settings window for Linear Elastic Material, locate the Linear Elastic Material 
section.

3 From the Material symmetry list, choose Anisotropic.

Wrinkling 1
1 In the Physics toolbar, click Attributes and choose Wrinkling.

2 In the Settings window for Wrinkling, locate the Wrinkling section.

3 From the Termination criterion for local method list, choose Step size or residual.

Thickness and Offset 1
1 In the Model Builder window, under Component 1 (comp1) > Membrane (mbrn) click 

Thickness and Offset 1.

2 In the Settings window for Thickness and Offset, locate the Thickness and Offset section.

3 In the d0 text field, type th.

Fixed Constraint 1
1 In the Physics toolbar, click Edges and choose Fixed Constraint.

2 Select Edges 2, 3, 7, and 11 only.

Prescribed Displacement 1
1 In the Physics toolbar, click Edges and choose Prescribed Displacement.

2 Select Edges 4, 5, 8, and 10 only.

3 In the Settings window for Prescribed Displacement, locate the Prescribed Displacement 
section.

4 From the Displacement in x direction list, choose Prescribed.

5 In the u0x text field, type (R11-1)*X+R12*Y+R13*Z.

6 From the Displacement in y direction list, choose Prescribed.

7 In the u0y text field, type R21*X+(R22-1)*Y+R23*Z.

8 From the Displacement in z direction list, choose Prescribed.
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9 In the u0z text field, type R31*X+R32*Y+(R33-1)*Z.

Add a Stabilization feature, in order to suppress the out-of-plane singularity of the 
unstressed membrane.

Stabilization 1
1 In the Physics toolbar, click Boundaries and choose Stabilization.

The fourth study runs with quadratic shape order of the elements, so add a Discretization 
node. To do so, you first need to activate advanced physics options.

2 Click the Show More Options button in the Model Builder toolbar.

3 In the Show More Options dialog, in the tree, select the checkbox for the node Physics > 
Advanced Physics Options.

4 Click OK.

Quadratic Discretization
1 In the Physics toolbar, click Global and choose Discretization.

2 In the Settings window for Discretization, locate the Discretization section.

3 From the Displacement field list, choose Quadratic Lagrange.

4 In the Label text field, type Quadratic Discretization.

Add a Material Switch node in order to run the same study with different materials.

M A T E R I A L S

Material Switch 1 (sw1)
In the Model Builder window, under Component 1 (comp1) right-click Materials and choose 
More Materials > Material Switch.

Isotropic Material
1 In the Model Builder window, right-click Material Switch 1 (sw1) and choose 

Blank Material.

2 In the Settings window for Material, type Isotropic Material in the Label text field.
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3 Locate the Material Contents section. In the table, enter the following settings:

Orthotropic Material
1 In the Model Builder window, right-click Material Switch 1 (sw1) and choose 

Blank Material.

2 In the Settings window for Material, type Orthotropic Material in the Label text field.

3 Locate the Material Contents section. In the table, enter the following settings:

The first study is for three-noded triangular elements, so choose the first mesh pattern.

Customize the study settings in order to achieve a better convergence.

S T U D Y :  T H R E E  N O D E D  T R I A N G U L A R  ( P A T T E R N  1 )

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Study: Three Noded Triangular (Pattern 
1) in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots checkbox.

Propert
y

Variable Value Unit Property group

Elasticit
y matrix

{D11, D12, D22, D13, 
D23, D33, D14, D24, 
D34, D44, D15, D25, 
D35, D45, D55, D16, 
D26, D36, D46, D56, 
D66} ; Dij = Dji

{DD11_iso, 
DD12_iso, 
DD22_iso, 0, 0, 
DD33_iso, 0, 0, 
0, DD44_iso, 0, 
0, 0, 0, 
DD55_iso, 0, 0, 
0, 0, 0, 
DD66_iso}

Pa Anisotropic

Density rho 0 kg/m³ Basic

Propert
y

Variable Value Unit Property group

Elasticit
y matrix

{D11, D12, D22, D13, 
D23, D33, D14, D24, 
D34, D44, D15, D25, 
D35, D45, D55, D16, 
D26, D36, D46, D56, 
D66} ; Dij = Dji

{DD11_orth, 
DD12_orth, 
DD22_orth, 0, 0, 
DD33_orth, 0, 0, 
0, DD44_orth, 0, 
0, 0, 0, 
DD55_orth, 0, 0, 
0, 0, 0, 
DD66_orth}

Pa Anisotropic

Density rho 0 kg/m³ Basic
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Material Sweep
1 In the Study toolbar, click More Study Extensions and choose Material Sweep.

2 In the Settings window for Material Sweep, locate the Study Settings section.

3 Click Add.

Step 1: Stationary
1 In the Model Builder window, click Step 1: Stationary.

2 In the Settings window for Stationary, click to expand the Study Extensions section.

3 Select the Auxiliary sweep checkbox.

4 Click Add.

5 In the table, enter the following settings:

Solution 1 (sol1)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node.

3 In the Model Builder window, expand the Study: Three Noded Triangular (Pattern 1) > 
Solver Configurations > Solution 1 (sol1) > Stationary Solver 1 node, then click 
Parametric 1.

4 In the Settings window for Parametric, click to expand the Continuation section.

5 From the Predictor list, choose Linear.

6 In the Model Builder window, under Study: Three Noded Triangular (Pattern 1) > 
Solver Configurations > Solution 1 (sol1) > Stationary Solver 1 click Fully Coupled 1.

7 In the Settings window for Fully Coupled, click to expand the Method and Termination 
section.

8 From the Nonlinear method list, choose Constant (Newton).

9 In the Maximum number of iterations text field, type 100.

10 From the Stabilization and acceleration list, choose Anderson acceleration.

11 In the Study toolbar, click Compute.

Add a second study for three-noded triangular elements having the second mesh pattern.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

Parameter name Parameter value list Parameter unit

theta (Rotation) range(0,0.5,10) deg
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2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies > Stationary.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y :  T H R E E  N O D E D  T R I A N G U L A R  ( P A T T E R N  2 )

1 In the Settings window for Study, type Study: Three Noded Triangular (Pattern 
2) in the Label text field.

2 Locate the Study Settings section. Clear the Generate default plots checkbox.

Material Sweep
1 In the Study toolbar, click More Study Extensions and choose Material Sweep.

2 In the Settings window for Material Sweep, locate the Study Settings section.

3 Click Add.

Step 1: Stationary
1 In the Model Builder window, click Step 1: Stationary.

2 In the Settings window for Stationary, click to expand the Mesh Selection section.

3 In the table, enter the following settings:

4 Locate the Study Extensions section. Select the Auxiliary sweep checkbox.

5 Click Add.

6 In the table, enter the following settings:

Customize the study settings as was done in Study 1 in order to achieve a better 
convergence.

7 In the Study toolbar, click Compute.

Add a third study for four-noded quadrilateral elements having the third mesh pattern.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

Component Mesh

Component 1 Triangular Mesh, Pattern 2

Parameter name Parameter value list Parameter unit

theta (Rotation) range(0,0.5,10) deg
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2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies > Stationary.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y :  F O U R  N O D E D  Q U A D R I L A T E R A L  ( P A T T E R N  3 )

1 In the Settings window for Study, type Study: Four Noded Quadrilateral (Pattern 
3) in the Label text field.

2 Locate the Study Settings section. Clear the Generate default plots checkbox.

Material Sweep
1 In the Study toolbar, click More Study Extensions and choose Material Sweep.

2 In the Settings window for Material Sweep, locate the Study Settings section.

3 Click Add.

Step 1: Stationary
1 In the Model Builder window, click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Mesh Selection section.

3 In the table, enter the following settings:

4 Locate the Study Extensions section. Select the Auxiliary sweep checkbox.

5 Click Add.

6 In the table, enter the following settings:

Customize the study settings as was done in Study 1 in order to achieve a better 
convergence.

7 In the Study toolbar, click Compute.

Add a fourth study for nine-noded quadrilateral elements having the fourth mesh pattern.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

Component Mesh

Component 1 Quadrilateral Mesh, Pattern 1

Parameter name Parameter value list Parameter unit

theta (Rotation) range(0,0.5,10) deg
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2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies > Stationary.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y :  N I N E  N O D E D  Q U A D R I L A T E R A L  ( P A T T E R N  4 )

1 In the Settings window for Study, type Study: Nine Noded Quadrilateral (Pattern 
4) in the Label text field.

2 Locate the Study Settings section. Clear the Generate default plots checkbox.

Material Sweep
1 In the Study toolbar, click More Study Extensions and choose Material Sweep.

2 In the Settings window for Material Sweep, locate the Study Settings section.

3 Click Add.

Step 1: Stationary
1 In the Model Builder window, click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 Select the Modify model configuration for study step checkbox.

4 In the tree, select Component 1 (comp1) > Membrane (mbrn), Controls spatial frame.

5 From the Discretization list, choose Quadratic Discretization.

6 Locate the Mesh Selection section. In the table, enter the following settings:

7 Locate the Study Extensions section. Select the Auxiliary sweep checkbox.

8 Click Add.

9 In the table, enter the following settings:

Customize the study settings as was done in Study 1 in order to achieve a better 
convergence.

10 In the Study toolbar, click Compute.

Component Mesh

Component 1 Quadrilateral Mesh, Pattern 2

Parameter name Parameter value list Parameter unit

theta (Rotation) range(0,0.5,10) deg
21 |  T O R S I O N  O F  A  C I R C U L A R  M E M B R A N E



R E S U L T S

Wrinkled Region
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Wrinkled Region in the Label text field.

3 Locate the Data section. From the Dataset list, choose 
Study: Three Noded Triangular (Pattern 1)/Parametric Solutions 1 (sol2).

4 From the Material Switch 1 list, choose Isotropic Material.

5 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.

6 Click to expand the Plot Array section. From the Array type list, choose Square.

Surface 1
1 In the Wrinkled Region toolbar, click Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1 (comp1) > Membrane > 
Wrinkling > mbrn.iswrinkled - Is wrinkled - 1.

3 Click to expand the Quality section. From the Evaluation settings list, choose Manual.

4 From the Resolution list, choose No refinement.

5 From the Smoothing list, choose None.

6 Click to expand the Plot Array section. Select the Manual indexing checkbox.

7 In the Row index text field, type 1.

Surface 2
1 Right-click Surface 1 and choose Duplicate.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Study: Three Noded Triangular (Pattern 2)/

Parametric Solutions 2 (sol6).

4 From the Material Switch 1 list, choose Isotropic Material.

5 Click to expand the Title section. From the Title type list, choose None.

6 Click to expand the Inherit Style section. From the Plot list, choose Surface 1.

7 Locate the Plot Array section. In the Row index text field, type 0.

Surface 3
1 Right-click Surface 2 and choose Duplicate.

2 In the Settings window for Surface, locate the Data section.
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3 From the Dataset list, choose Study: Four Noded Quadrilateral (Pattern 3)/

Parametric Solutions 3 (sol10).

4 Locate the Plot Array section. In the Row index text field, type 1.

5 In the Column index text field, type 1.

Surface 4
1 Right-click Surface 3 and choose Duplicate.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Study: Nine Noded Quadrilateral (Pattern 4)/

Parametric Solutions 4 (sol14).

4 Locate the Plot Array section. In the Row index text field, type 0.

Wrinkled Region
1 In the Model Builder window, click Wrinkled Region.

2 In the Settings window for 3D Plot Group, click to expand the Title section.

3 From the Title type list, choose Custom.

4 Find the Layout subsection. Clear the Use parameter indicator for solution and phase 
checkbox.

5 Click the Go to XY View button in the Graphics toolbar.

6 Click the Show Grid button in the Graphics toolbar.

7 Click the Show Axis Orientation button in the Graphics toolbar.

Wrinkled Region 1
Right-click Wrinkled Region and choose Duplicate.

Set default units for result presentation.

Preferred Units 1
1 In the Results toolbar, click Configurations and choose Preferred Units.

2 In the Settings window for Preferred Units, locate the Units section.

3 Click Add Physical Quantity.

4 In the Physical Quantity dialog, type stress in the text field.

5 In the tree, select Solid Mechanics > Stress tensor (N/m^2).

6 Click OK.

7 In the Settings window for Preferred Units, locate the Units section.
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8 In the table, enter the following settings:

9 Click Apply.

First Principal Stress
1 In the Model Builder window, under Results click Wrinkled Region 1.

2 In the Settings window for 3D Plot Group, type First Principal Stress in the Label 
text field.

3 Click to expand the Window Settings section. Locate the Color Legend section. From the 
Position list, choose Right double.

Surface 1
1 In the Model Builder window, expand the First Principal Stress node, then click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.sp1.

4 Locate the Coloring and Style section. From the Color table list, choose Prism.

Surface 2
1 In the Model Builder window, click Surface 2.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.sp1.

4 Locate the Inherit Style section. From the Plot list, choose None.

5 Locate the Coloring and Style section. From the Color table list, choose Prism.

Surface 3
1 In the Model Builder window, click Surface 3.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.sp1.

4 Locate the Inherit Style section. From the Plot list, choose None.

5 Locate the Coloring and Style section. From the Color table list, choose Prism.

Surface 4
1 In the Model Builder window, click Surface 4.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.sp1.

Quantity Unit Preferred unit

Stress tensor N/m^2 kPa
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4 Locate the Inherit Style section. From the Plot list, choose None.

5 Locate the Coloring and Style section. From the Color table list, choose Prism.

First Principal Stress
1 In the Model Builder window, click First Principal Stress.

2 In the Settings window for 3D Plot Group, locate the Color Legend section.

3 Select the Show maximum and minimum values checkbox.

4 In the First Principal Stress toolbar, click Plot.

Second Principal Stress
1 Right-click First Principal Stress and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Second Principal Stress in the Label 
text field.

Surface 1
1 In the Model Builder window, expand the Second Principal Stress node, then click 

Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.sp2.

Surface 2
1 In the Model Builder window, click Surface 2.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.sp2.

Surface 3
1 In the Model Builder window, click Surface 3.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.sp2.

Surface 4
1 In the Model Builder window, click Surface 4.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.sp2.

4 In the Second Principal Stress toolbar, click Plot.

Second Principal Stress
In the Model Builder window, collapse the Results > Second Principal Stress node.
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Maximum Wrinkling Measure (Isotropic)
1 In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, type Maximum Wrinkling Measure 
(Isotropic) in the Label text field.

3 Locate the Data section. From the Dataset list, choose 
Study: Three Noded Triangular (Pattern 1)/Parametric Solutions 1 (sol2).

4 From the Material Switch 1 list, choose First.

5 From the Parameter selection (theta) list, choose Last.

Surface Maximum 1
1 Right-click Maximum Wrinkling Measure (Isotropic) and choose Maximum > 

Surface Maximum.

2 In the Settings window for Surface Maximum, locate the Selection section.

3 From the Selection list, choose All boundaries.

4 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1 (comp1) > Membrane > Wrinkling > mbrn.lemm1.wr1.Beta -

Wrinkling measure, material frame - 1.

Surface Maximum 2
1 Right-click Surface Maximum 1 and choose Duplicate.

2 In the Settings window for Surface Maximum, locate the Data section.

3 From the Dataset list, choose Study: Three Noded Triangular (Pattern 2)/

Parametric Solutions 2 (sol6).

4 From the Material Switch 1 list, choose First.

5 From the Parameter selection (theta) list, choose Last.

Surface Maximum 3
1 Right-click Surface Maximum 2 and choose Duplicate.

2 In the Settings window for Surface Maximum, locate the Data section.

3 From the Dataset list, choose Study: Four Noded Quadrilateral (Pattern 3)/

Parametric Solutions 3 (sol10).

Surface Maximum 4
1 Right-click Surface Maximum 3 and choose Duplicate.

2 In the Settings window for Surface Maximum, locate the Data section.

3 From the Dataset list, choose Study: Nine Noded Quadrilateral (Pattern 4)/

Parametric Solutions 4 (sol14).
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Maximum Wrinkling Measure (Isotropic)
1 In the Model Builder window, click Maximum Wrinkling Measure (Isotropic).

2 In the Settings window for Evaluation Group, locate the Transformation section.

3 Select the Transpose checkbox.

4 In the Maximum Wrinkling Measure (Isotropic) toolbar, click Evaluate.

First Principal Stress, Second Principal Stress, Wrinkled Region
1 In the Model Builder window, under Results, Ctrl-click to select Wrinkled Region, 

First Principal Stress, and Second Principal Stress.

2 Right-click and choose Group.

Isotropic Material
In the Settings window for Group, type Isotropic Material in the Label text field.

Orthotropic Material
1 Right-click Isotropic Material and choose Duplicate.

2 In the Settings window for Group, type Orthotropic Material in the Label text field.

Wrinkled Region 1
1 In the Model Builder window, expand the Orthotropic Material node, then click 

Wrinkled Region 1.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 2
1 In the Model Builder window, expand the Wrinkled Region 1 node, then click Surface 2.

2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 3
1 In the Model Builder window, click Surface 3.

2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 4
1 In the Model Builder window, click Surface 4.

2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.
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4 In the Wrinkled Region 1 toolbar, click Plot.

First Principal Stress 1
1 In the Model Builder window, under Results > Orthotropic Material click 

First Principal Stress 1.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 2
1 In the Model Builder window, expand the First Principal Stress 1 node, then click 

Surface 2.

2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 3
1 In the Model Builder window, click Surface 3.

2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 4
1 In the Model Builder window, click Surface 4.

2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

4 In the First Principal Stress 1 toolbar, click Plot.

Second Principal Stress 1
1 In the Model Builder window, under Results > Orthotropic Material click 

Second Principal Stress 1.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 2
1 In the Model Builder window, expand the Second Principal Stress 1 node, then click 

Surface 2.

2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 3
1 In the Model Builder window, click Surface 3.
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2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

Surface 4
1 In the Model Builder window, click Surface 4.

2 In the Settings window for Surface, locate the Data section.

3 From the Material Switch 1 list, choose Orthotropic Material.

4 In the Second Principal Stress 1 toolbar, click Plot.

Maximum Wrinkling Measure (Orthotropic)
1 In the Model Builder window, right-click Maximum Wrinkling Measure (Isotropic) and 

choose Duplicate.

2 In the Settings window for Evaluation Group, type Maximum Wrinkling Measure 
(Orthotropic) in the Label text field.

3 Locate the Data section. From the Material Switch 1 list, choose Last.

Surface Maximum 2
1 In the Model Builder window, expand the Maximum Wrinkling Measure (Orthotropic) 

node, then click Surface Maximum 2.

2 In the Settings window for Surface Maximum, locate the Data section.

3 From the Material Switch 1 list, choose Last.

Surface Maximum 3
1 In the Model Builder window, click Surface Maximum 3.

2 In the Settings window for Surface Maximum, locate the Data section.

3 From the Material Switch 1 list, choose Last.

Surface Maximum 4
1 In the Model Builder window, click Surface Maximum 4.

2 In the Settings window for Surface Maximum, locate the Data section.

3 From the Material Switch 1 list, choose Last.

4 In the Maximum Wrinkling Measure (Orthotropic) toolbar, click Evaluate.
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